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Lab 5: Experimentations with Multisim 

 

The goal of this laboratory is to learn some useful features of the Multisim simulation software and to 
highlight some differences between the computations as they are done in class and the results of 
Multisim simulations and benchtop experiments.  

We use a guided discovery approach, in which we do pencil-and-paper computations of the circuit 
outputs to gain a basic understanding of how these circuits work. In the lab, we will build the circuits 
in Multisim first, to examine how they behave in simulation and identify some differences between 
the computations and the simulations. Last, we build the circuits on the benchtop with hardware to 
further understand how the real circuits differ from the simulated systems. 

Prelab: 

In exercise 1, you will work with the circuit below: 

 

Multisim has a generic blue LED which turns on when the LED current is 5 mA. In the lab, you will 
work with the blue LED you used in a previous lab (reference C503B-BCN). For the pre-lab: 

1) Determine the setting of the potentiometer that sets the LED current to 10 mA. What are 
voltages A, B, and C for this setting of the potentiometer. 

2) Determine the setting of the potentiometer for which the current exceeds the maximum 
current of one of the Zener diodes. Which Zener diode reaches its maximum current first when 
the potentiometer resistance is decreased. 

In exercise 2, you will work with the circuit shown below: 
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The waveform generator is used to represent an ac voltage source. The frequency is set to 60 Hz and 
the amplitude of the sine wave is set to 10 V, peak. The DF06MA diode bridge is of the same family 
as the DF02 and DF04 diode bridges you used in a previous lab.  

For the prelab, estimate the dc (i.e. mean) load voltage, dc load current, dc diode current, and peak-
to-peak ripple voltage. 

Based on the data sheet, what range of dc diode drop do you expect to see given the expected diode 
current? 

Determine the ripple voltage when the capacitance is changed to 4.7 µF, 2.2 µF, and 1 µF. Do you 
believe these values to be correct? Explain your argument. 

In exercise 3, you work with an operational amplifier used to build a non-inverting amplifier. The 
amplifier receives its input from the function generator and displays its output on the oscilloscope. 
The circuit is shown below.  

 

Determine the gain of the amplifier and the peak-to-peak load voltage when the waveform 
generator settings are f = 100 Hz, amplitude = 50 mV peak. Determine the peak load current when 
the input amplitude is 50 mV peak. Estimate the peak load current when the load resistance is 10 
kΩ, 1 kΩ, 100 Ω, 10 Ω. Recall the actual op-amp device needs to be powered and in the diagram 
above, V+ = 12 V and V- = -12 V.  

You will turn-in a draft of your answers as prelab for this assignment. Show drawings of all the 
circuits and the results of all the analyses/calculations you did for the prelab. 
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Lab room experimentation: 

Part 1: DC diode circuit 

A. Developing a circuit for simulation 

Start Multisim.  

Build the circuit shown in the first pre-lab exercise. Place one of the two Zener diodes on the sheet. 
Highlight the diode and press CTRL-R to rotate the diode by 90 degrees clockwise. 

The “In Use List” drop down menu in the top toolbar can be used to retrieve components you 
already place on the sheet to replicate them. Select the diode you previously placed and drop it on 
the sheet. Then, right click and select “replace component” to access the available Zener diodes in 
the data base. Replace with the other Zener diode. 

Place all the other components from the pre-lab circuit on the sheet. Wire all the components 
together to build the circuit from the pre-lab. 

Net names can be changed and used to document your design. Double-click on the wire between 
the potentiometer and the diodes. Set the preferred net name to “Input_voltage” then press “ok”. 

Labels can be set to document the design. Double click on the blue LED and set the label to “Blue 
LED”. 

Text and drawings help further illustrate and document the design. Select “Place – Text” and type in 
the reference of the blue LED: C503B-BCN next to the LED. Place a Letter A next to the wire between 
the LED and the top Zener. Select “Place – Graphics” to draw a line between the letter A and the 
junction between the LED and the top Zener. Right click on the wire and select “Arrow” to create a 
pointing arrow between the letter A and the net. Repeat to label the other nets that join the 
different diodes to each other. Save your design. 

B. Configure Multisim 

Then, you explore options to configure the appearance of the display. You will set the sheet 
Properties parameters which affect the interface for the design of the current circuit. 

Select Options»Sheet Properties. 

Click the Sheet visibility tab. In the Component section, enable/disable the options such as Labels, 
RefDes, and Values and preview the result by selecting “Apply” at the bottom of the tab. Configure 
to have the labels and values enabled. (Labels are made of text you choose yourself to document 
your design. RefDes are selected by Multisim and reflect the type of component: D for diode, R for 
resistor, … and the order in which these components are placed on the sheet). 

In the Net names subsection, you can choose if you want to have net (nodes) names shown for all 
nets, hide all, or a net-specific setting (recommended). For this exercise, select Show all. Note that 
net 0 is reserved for the ground reference in all circuits. 
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In the Colors tab you can change the colors used in the workspace. The default is a pre-configured 
White Background option. Change the menu option to (black & white) and select “apply”. Then 
switch to “Custom”.  Set the Components with model to blue, wires to green, and text to red. Select 
“Apply”. Set to a color pattern you are comfortable with and select “Apply” again. 

Click the Workspace tab. In this tab you can turn on or off the grid, page bounds, and the page 
border. You can also change the sheet size and units. Experiment with turning the grid on and off. 

Click the Wiring tab. Set the Wire width to 2. Then Click OK to exit the Sheet Properties. 

 Then, you explore options to configure Multisim more generally.   

Select Options»Global Preferences. 

Select the Paths tab and set the Design default path to the desktop folder on your computer (use … 
at the end of the present path to reconfigure). Select “Apply”. 

Select the Simulation tab and set the background color for the graphs and instruments to White. 
Select “Apply”. 

Select the Save tab. If you want to have a Security Copy created every time you save the circuit; you 
can also configure an Auto-backup that will save the circuit at every interval you specify. You can 
also Save simulation data with instruments, which allows you to specify how much data will be saved 
with the instruments included in your schematic. Only check the “Auto-backup” tab and select 
“Apply”. 

Select the Components tab. In this tab you can select how the Component Browser behaves every 
time you place a component and what Symbol standard to use. 

Select the General tab. You can customize the behavior of many tasks in this tab such as selecting 
components, using the mouse-wheel, and most importantly, Wiring. 

Click OK to close the Global Preferences dialog.  Note that the “Sheet properties” apply to the design 
file you are working with and are saved with the file itself. “Global preferences” apply to every 
design project you are working with, and are not saved with the file, these preferences are saved in 
a User Configuration file. 

C. Running the simulation 

Press on the green arrow in the top toolbar to start the simulation. Press A and shift-A to vary the 
resistance of the potentiometer.  

For what value of the resistance does the LED light up?  

Place a voltage probe between the LED and the 1N5235B Zener. The default probe displays 
parameters for the peak-to-peak, rms, and instantaneous voltage, as well as frequency which are 
irrelevant here since we are working with a dc circuit. 
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Double click on the probe and on the appearance tab, set the font to 12 to make the display more 
readable. Then, select apply. On the parameters tab, select “custom”, then “show” to place a check 
mark only next to V(dc). Then press “OK”.  

Place a current probe on the sheet and configure it to show only I(dc). Then press “OK”.   

Adjust the potentiometer so that the LED current is 10 mA (You will need to stop the simulation and 
modify the potentiometer value so that the incremental change in resistance is 0.1%). Compare the 
value you obtained from the simulation with the computations from the pre-lab. 

Move the probe to measure the voltage at points A, B, and C. Compare with the computations you 
did for the prelab.  

Stop the simulation. Place a vertical ammeter in your circuit (from the indicator toolbar). Run the 
simulation again. Note that the probe is much more convenient than the ammeter because it can be 
configured and moved while the simulation is running. The ammeter can simulate a more realistic 
device than the probe because its internal resistance can be modified. 

D. Assembling the hardware and measuring the voltages and currents 

Assemble on the protoboard the same circuit as that used in the pre-lab and in the Multisim 
simulation.  

For the potentiometer, the 3 leads must be inserted as is without any bend in the protoboard. Then 
build the circuit by extending wires between the “wiper” and one end lead of the potentiometer. 

In your circuit, include the ammeter from virtual bench. Set the maximum current on the virtual 
bench power supply to 20 mA. (Why do we take this precaution?) 

Power up the circuit and adjust the potentiometer position to set the circuit current to 10 mA. 
Measure the voltages at the nodes in the circuit that correspond to points A, B, and C in the drawing 
and simulation. 

Turn off the power. Disconnect the wires that extend from the potentiometer to the other elements 
of the circuit and measure with the ohmmeter the resistance of the potentiometer. 

Part 2: Filtered rectifier circuit 

A. Develop the filtered rectifier circuit in Multisim 

On a new sheet, assemble the filtered rectifier circuit from the pre-lab. Use a 10 µF capacitor and 
the DF06 diode bridge. 
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From the instrument toolbar on the right, place the waveform generator on the circuit. Wire the 
positive terminal and the center (COM) terminal to the ac pins of the diode bridge. 

Double click on the function generator symbol to open its front panel. Configure to generate a sine 
wave with a 60 Hz frequency and a 10 V peak amplitude. The front panel for all instruments is a 
floating window, which means you can leave it open and continue working with your circuit or run 
the simulation. The settings of the instrument can be changed while the simulation is running. When 
you close the window, the last configuration settings remain applied to the instrument. 

Place a two-channel oscilloscope and wire channel A to the load terminal. Double click on the wire 
and change the net color (I used red). When the simulation runs, the oscilloscope trace color 
matches that of the net. 

Run the simulation.  Configure the oscilloscope time base and channel A (try 2 V/div, Ypos = -3). Use 
the cursors to estimate on the display the dc voltage. 

Change the channel A setting to AC to only see the oscillatory portion of the waveform.  Change the 
channel A settings to see the AC waveform fill the display. Use the cursors to estimate the peak to 
peak ripple. (You may stop the simulation to “freeze” the waveform). 

Press the “save” button on the oscilloscope. Select a file name and for the file type, select “.lvm”. 
Save the file on the desktop. Open the file with Excel. Below the preamble, you will see time values 
(X) and the trace 1 values (Channel A) organized in two columns. Create an X-Y graph to display a few 
cycles of the waveform. 

Return to Multisim. Place a voltage probe at the location of the load and configure the probe to 
display the dc voltage, the peak-to-peak voltage (i.e. the ripple), and the frequency. Run the 
simulation and compare to the readings on the scope display. Use a current probe to measure the dc 
load voltage. 

Modify the circuit to set the capacitor value to 4.7 µF, 2.2 µF, and 1 µF. Measure with the probe or 
on the oscilloscope the dc voltage and the ripple. Compare your simulations with the results of the 
prelab. 

B. Assembling the hardware and measuring the dc output voltage and ripple voltage 
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Assemble on the protoboard the filtered diode rectifier from the pre-lab and Multisim simulations. 
Use a DF02 or DF04 diode bridge. 

Use the waveform generator from the virtual bench device to power up your bridge circuit. Use the 
oscilloscope probe to measure the load voltage. 

Turn on the virtual bench and tabulate the dc voltage and peak-to-peak ac voltage (i.e. the ripple 
voltage) for 4 or 5 values of the capacitance between 22 µF and 1 µF (depending on availability of 
parts in the lab). Estimate the dc load current. 

Part 3: Op-amp amplifier 

A. Develop the op-amp amplifier in Multisim 

On a new sheet, assemble the op-amp amplifier circuit shown below. Use a LM 741 H op-amp. To 
power the device, connect two 12 V dc supplies as shown on the diagram. Wire the middle point to 
ground.  

From the menu, select “place – connector – on page connector”. Drop the connector on the sheet. 
Name the connector V+ and attach to the positive side of the top +12 V supply. Repeat with a 
second “on page connector”. Name the connector V- and attach to the negative side of the bottom 
+12 V supply. 

Wire the op-amp with its 100 kΩ feedback resistor, 1 kΩ input resistor, and 10 kΩ load resistor. 
Select “place connector – on page connector” one more time. After the connector is dropped on the 
sheet, select to associate it to V+, then wire the connector to pin 7 of the op-amp. Repeat and use 
another connector associated to V- for pin 4 of the op-amp. Using connectors in this way minimizes 
the long wires connected to the power supplies of complex circuits. 

 

Run the simulation with the waveform generator set to a frequency of 100 Hz, 1000 Hz, 10,000 Hz, 
100,000 Hz. What do you observe for the amplitude of the output waveform?  

Double click on the net at the output of the op-amp and note the net number. Set the preferred net 
name to “output”. To capture the effect of frequency on the amplifier gain in one shot, we can use 
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the analysis capability of Multisim. On the menu bar, select “simulate – analyses and simulations – 
ac sweep”.  

Configure the frequency parameters to range from 1 Hz to 1,000,000 Hz with 100 points per decade. 

Click on the output tab. Among the variables in the circuit, select V(output) and add it to the 
variables for analysis. Press “run”. Multisim displays a plot of the amplitude and phase of the output 
voltage as a function of frequency. Select “Cursor – show cursor” on the menu.  

Use the cursor to measure the amplitude (y) of the output voltage at multiple frequencies between 
100 Hz and 100 KHz. On the top menu, select “Export to Excel” to export the frequency response of 
the op-amp amplifier. Save the excel sheet. 

While sweeping in frequency and measuring the amplifier output would be relative straightforward 
to do on the bench, other types of simulations are more difficult to do with real devices. 

Replace the waveform generator at the input with a DC power supply set to deliver a voltage of 50 
mV. On the menu bar, select “simulate – analyses and simulations – parameter sweep” to change 
the value of the load resistor between 1 Ω and 1000 Ω. Configure the sweep to “device parameter”. 
Device type to “resistor”. The resistor is the DefRes of the load (R3 in the image below). Configure 
the sweep to go from 1 Ω to 1 kΩ in 101 points and to display the “DC operating point”. 

 

Run the simulation. The graph shows the voltage output amplitude for an input of 50 mV. The 
output voltage increases when the resistance increases to about 200 ohms and then stabilizes to the 
expected value of ~ 5 V. Export the data to Excel. Note that the resistance for which the output 
plateaus. Use the Excel sheet to compute the output current of the op-amp. What do you notice in 
the relation between load resistance and output current? 

B. Develop the op-amp amplifier on the benchtop 

Build the op-amp amplifier circuit on your protoboard with a 10 kΩ load. Use a 741 op-amp powered 
with +/- 12 volt supplies from the virtual bench device.  
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Connect the input of the op-amp amplifier to the waveform generator. Connect the input and the 
output of the amplifier to the two channels of the oscilloscope. 

Set the input voltage amplitude to a value you select knowing the amplifier gain and the power 
supply voltages of the op-amp (the output cannot get out of the range of the supply voltages). 
Measure the amplitude of the output voltage when the input frequency is varied between 100 Hz 
and 100 kHz. Take at least 10 measurements. Compute the amplifier gain for the frequencies you 
tested. 

Set the frequency at 10 kHz.  Change the feedback resistor so the gain of the amplifier is 2, 11, 101, 
1001. Adjust the input voltage amplitude as necessary. Measure the amplitude of the output voltage 
for the different gains. 

Report: 

Each work group will submit a report due one week after the laboratory experiment which should 
include the following sections: 

1. For the first circuit, report your calculations from the prelab, the results of the simulations, 
and the results of the experimentation (including screenshots of the Multisim and 
virtualbench displays). Tabulate these results to highlight the comparison and perform an 
error analysis to compare the pencil-and-paper computations and the Multisim simulations 
to the experimental measurements. Discuss the differences and sources of error. 

2. For the second circuit, report your calculations from the prelab, the results of the 
simulations, and the results of the experimentation (including screenshots of the Multisim 
and virtualbench displays). Tabulate these results to highlight the comparison and perform 
an error analysis to compare the pencil-and-paper computations and the Multisim 
simulations to the experimental measurements. Discuss the differences and sources of 
error. 

3. For the third circuit, report your calculations from the prelab, the results of the simulations, 
and the results of the experimentation (including screenshots of the Multisim and 
virtualbench displays). Tabulate and plot the results to show the effect of the input 
frequency and load resistance on the amplifier gain (from the simulations) and the effect of 
the input frequency and amplifier anticipated gain (1+Rf/Ri) on the actual gain measured as 
Vout/Vin at 10 kHz. Discuss these results to highlight the comparison and perform an error 
analysis to compare the pencil-and-paper computations, the Multisim simulations to the 
experimental measurements. Discuss the differences and sources of error. 


